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Reference to the whole or to part of this volume should be made as follows: 
Print citation for Chapter 1:
Shipboard Scientific Party, 2003. Leg 201 summary. In D’Hondt, S.L., Jørgensen, B.B., Miller, D.J., et 
al., Proc. ODP, Init. Repts., 201: College Station TX (Ocean Drilling Program), 1–81.

CD-ROM volume citation:
D’Hondt, S.L., Jørgensen, B.B., Miller, D.J., et al., 2003. Proc. ODP, Init. Repts., 201 [CD-ROM]. 
Available from: Ocean Drilling Program, Texas A&M University, College Station TX 77845-9547, USA.

CD-ROM chapter citation:
Shipboard Scientific Party, 2003. Site 1225. In D’Hondt, S.L., Jørgensen, B.B., Miller, D.J., et al., Proc. 
ODP, Init. Repts., 201, 1–86 [CD-ROM]. Available from: Ocean Drilling Program, Texas A&M University, 
College Station TX 77845-9547, USA.

This volume also appears on the World Wide Web. See www-odp.tamu.edu/publications for Web 
citation formats.

http://www-odp.tamu.edu/publications
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Effective publication dates of ODP Proceedings

According to the International Code of Zoological Nomenclature, the date of publication of a work 
and of a contained name or statement affecting nomenclature is the date on which the publication 
was mailed to subscribers, placed on sale, or when the whole edition is distributed free of charge, 
mailed to institutions and individuals to whom free copies are distributed. The mailing date, not the 
printing date, is the correct one.

The printing date of this volume: May 2003

The mailing dates of recent Proceedings of the Ocean Drilling Program:

Volume 174AX Supplement (Initial Reports): February 2003
Volume 199 (Initial Reports): November 2002
Volume 200 (Initial Reports): January 2003
Volume 174A (Scientific Results): February 2003
Volume 177 (Scientific Results): March 2003
Volume 178 (Scientific Results): December 2002

Copies of this publication may be obtained from Publications Distribution Center, Ocean Drilling 
Program, Texas A&M University, 1000 Discovery Drive, College Station TX 77845-9547, USA. See the 
ODP publication list at www-odp.tamu.edu/publications or contact ODP for prices and ordering 
information. Orders for copies require advance payment.

ISSN
Book: 0884-5883; CD-ROM: 1096-2522; World Wide Web: 1096-2158
Library of Congress 87-642-462

http://www-odp.tamu.edu/publications
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PUBLISHER’S NOTES
This volume also appears on the World Wide Web. Any scientific corrections, revisions, or additions will 
be noted in the chapter (see “Chapter Notes”) at www-odp.tamu.edu/publications.

This publication was prepared by the Ocean Drilling Program, Texas A&M University, as an account of 
work performed under the international Ocean Drilling Program, which is managed by Joint 
Oceanographic Institutions, Inc., under contract with the National Science Foundation. Funding for 
the program was provided by the following agencies at the time of this cruise:
Australia/Canada/Chinese Taipei/Korea Consortium for Ocean Drilling: Department of Primary Industries and 
Energy (Australia), Natural Resources Canada, National Taiwan University in Taipei, and Korean Institute for 
Geology, Mining and Minerals

Deutsche Forschungsgemeinschaft (Federal Republic of Germany)

European Science Foundation Consortium for Ocean Drilling (Belgium, Denmark, Finland, Iceland, Ireland, Italy, 
The Netherlands, Norway, Portugal, Spain, Sweden, and Switzerland)

Institut National des Sciences de l’Univers–Centre National de la Recherche Scientifique (INSU-CNRS) (France)

Marine High-Technology Bureau of the State Science and Technology Commission of the People’s Republic of 
China

National Science Foundation (United States)

Natural Environment Research Council (United Kingdom)

University of Tokyo, Ocean Research Institute (Japan)

http://www-odp.tamu.edu/publications
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Any opinions, findings, and conclusions or recommendations expressed in this publication are those of 
the author(s) and do not necessarily reflect the views of the National Science Foundation, the 
participating agencies, Joint Oceanographic Institutions, Inc., Texas A&M University, or Texas A&M 
Research Foundation.

Abbreviations for names of organizations and publications in ODP reference lists follow the style given 

in Chemical Abstracts Service Source Index (published by American Chemical Society).

The bulk of the shipboard-collected data from this leg is available on the World Wide Web and is 
accessible at www-odp.tamu.edu/database. If you cannot access this site or need additional data, 
please contact the ODP Data Librarian, Ocean Drilling Program, Texas A&M University, College Station 
TX 77845-9547, USA. E-mail: database@odpemail.tamu.edu.

Supplemental data on the volume CD-ROM were provided by the authors and may not conform to 
ODP publication formats.

A site map showing the drilling locations for this leg and maps showing the drilling locations of all 
Ocean Drilling Program (ODP) and Deep Sea Drilling Project (DSDP) drilling sites are available on the 
volume CD-ROM in PDF format. These maps were produced using Generic Mapping Tools (GMT) of 
Paul Wessel and Walter H.F. Smith (gmt.soest.hawaii.edu).

Cover photograph by ODP Photographer John Beck is of the JOIDES Resolution under way.

http://www-odp.tamu.edu/database
mailto:database@odpemail.tamu.edu
http://gmt.soest.hawaii.edu
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FOREWORD

BY JOINT OCEANOGRAPHIC INSTITUTIONS, INC.

This volume presents scientific and engineering results from the Ocean Drilling Program (ODP). These results 
address the scientific and technical goals of the program, which are focused on the study of the dynamics of 
Earth’s interior and environment, the evolution of oceanic crust, and the fluctuations of climate. In addition, 
study of the Earth’s deep biosphere is an emergent research objective.

ODP, an international partnership of scientists and research institutions from 22 countries, operates the drillship 
JOIDES Resolution. This state-of-the-art research vessel contains eight levels of laboratories and other scientific 
facilities required for carrying out the program’s objectives.

The management of ODP involves a partnership of scientists and governments. International oversight and 
coordination are provided by the ODP Council, which is made up of representatives from the member 

countries. Overall scientific and management guidance is provided by representatives from the Joint 
Oceanographic Institutions for Deep Earth Sampling (JOIDES).

Joint Oceanographic Institutions, Inc. (JOI), a nonprofit consortium of 18 U.S. oceanographic institutions, serves 
as the National Science Foundation’s prime contractor for ODP. JOI implements scientific objectives, plans, and 
recommendations of the JOIDES committees through major subcontracts to Texas A&M University (TAMU) for 
science operations and to Lamont-Doherty Earth Observatory (LDEO) of Columbia University for geochemical 
and geophysical well-logging services.

JOI, TAMU, and LDEO have worked together successfully for many years to manage the Ocean Drilling 
Program. We look forward to many exciting discoveries and continued international collaboration as we further 
our scientific mission, especially the planning for the future of ocean drilling beyond 2003.

Steven R. Bohlen
President of the Joint Oceanographic Institutions and Executive Director of the Ocean Drilling Programs
Washington, D.C.
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Arlington VA 22230, USA
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http://www.nsf.gov/
http://www.oceandrilling.org/
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University of Washington, College of Ocean and 
Fishery Sciences

Woods Hole Oceanographic Institution

Australia/Canada/Chinese Taipei/Korea 
Consortium for Ocean Drilling: Department of 
Primary Industries and Energy (Australia), 
Natural Resources Canada, National Taiwan 
University in Taipei, and Korean Institute for 
Geology, Mining and Minerals

European Science Foundation Consortium for 
Ocean Drilling (Belgium, Denmark, Finland, 
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JOIDES Office
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Miami FL 33149, USA
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http://www.oceandrilling.org/
mailto:joides@rsmas.miami.edu
http://joides.rsmas.miami.edu
mailto:joi@joiscience.org
http://www.joiscience.org
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ODP SCIENCE OPERATOR

Ocean Drilling Program
Texas A&M University
1000 Discovery Drive
College Station TX 77845-9547, USA
Tel: (979) 845-2673; Fax: (979) 845-4857
E-mail: odp@odpemail.tamu.edu

ODP SITE SURVEY DATA BANK

Lamont-Doherty Earth Observatory
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PO Box 1000, 61 Route 9W
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Borehole Research Group
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E-mail: borehole@ldeo.columbia.edu
Web site: www.ldeo.columbia.edu/BRG/ODP

Web site: www.ldeo.columbia.edu/databank

mailto:odp@odpemail.tamu.edu
http://www-odp.tamu.edu/
mailto:borehole@ldeo.columbia.edu
http://www.ldeo.columbia.edu/BRG/ODP
mailto:odp@ldeo.columbia.edu
http://www.ldeo.columbia.edu/databank
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mailto:miller@odpemail.tamu.edu
mailto:iaiello@mlml.calstate.edu
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CD-ROM CONTENTS: ASCII TABLES
This CD-ROM contains ASCII versions of geochemistry data tables from the text and all of the smear 
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found listed below. 

You can access these data directly from the PDF files. Depending on your computer platform, the 
following information applies.

PC COMPUTERS
By default, double-clicking on a filename with a .TXT extension will launch the Notepad application. 
You can configure your computer’s operating system so that files on this CD with .TXT extensions 
automatically open in other software, such as Microsoft Excel. Follow these steps from the pull-down 
menu: Windows 95 and NT operating systems: View > Options > File Types; and Windows 98, 2000, 
ME, and XP systems: View > Folder Options > File Types.
MACINTOSH COMPUTERS
All table files with .TXT extensions will automatically open into Excel. If you do not have Excel installed 
on your computer, you may view these files through other spreadsheet or text-editor programs. Open 
the application of your choice, select File > Open, and open the ASCII file.

UNIX COMPUTERS
You can open files with .TXT extensions in any text editor or spreadsheet program but not directly 
from PDF files.

Chapter 3 Chapter 8 Chapter 11 

Chapter 6 Chapter 9 Chapter 12 

Chapter 7 Chapter 10 Smear slide data tables
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Table T5. Calcium carbonate and organic carbon concentrations, Holes 1225A and 1225C.

Chapter 7, Site 1226
Table T3. Interstitial water chemistry, Holes 1226B and 1226E.
Table T4. Iron concentrations of replicate interstitial water passed through different filters, Hole 
1226B.
Table T5. Methane concentrations in headspace, Holes 1226B and 1226E.
Table T6. Hydrogen concentrations for incubated headspace samples, Holes 1226B and 1226E.
Table T7. Concentrations of carbonate, total organic carbon, total nitrogen, and total sulfur, Holes 
1226B and 1226E.

Chapter 8, Site 1227
Table T2. Concentrations of dissolved species in interstitial waters, Holes 1227A and 1227D.
Table T3. Hydrocarbon gas concentrations in headspace, Holes 1227A and 1227D.
Table T4. Calculated interstitial water hydrogen in incubated samples, Holes 1227A and 1227D.

Chapter 9, Site 1228
Table T2. Concentrations of dissolved species in interstitial water, Holes 1228A, 1228B, 1228C, and 
1228E.

Table T3. Hydrocarbon gas concentrations in headspace, Holes 1228A and 1228B.
Table T4. Hydrogen concentrations, Holes 1228A and 1228E.
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Chapter 10, Site 1229
Table T2. Concentrations of dissolved species in interstitial waters, Holes 1229A and 1229D.
Table T3. Hydrocarbon gas concentrations in headspace, Holes 1229A and 1229D.
Table T4. Hydrogen concentrations, Holes 1229A and 1229D.

Chapter 11, Site 1230
Table T2. Concentrations of dissolved species in interstitial water, Holes 1230A, 1230B, and 1230C.
Table T3. Dissolved sulfate, Hole 1230A.
Table T4. Hydrogen concentrations, Holes 1230A and 1230C.
Table T5. Hydrocarbon gas concentrations in headspace, Hole 1230A.
Table T6. Hydrocarbon gas analyses of vacutainer samples, Hole 1230A.
Table T7. Rock-Eval pyrolysis of sediments.

Chapter 12, Site 1231

Table T3. Concentrations of dissolved species in interstitial waters, Holes 1231B and 1231E.
Table T4. Oxygen concentrations by microelectrode, Hole 1231D.
Table T5. Iron concentrations of replicate interstitial waters passed through different filters, Hole 
1231E.

Table T6. Hydrogen concentrations, Hole 1231B.
Table T7. Methane concentrations in headspace, Hole 1231B.

Smear Slide Data Tables
Site 1225 smear slide table.
Site 1226 smear slide table.
Site 1227 smear slide table.
Site 1228 smear slide table.
Site 1229 smear slide table.
Site 1230 smear slide table.
Site 1231 smear slide table.
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CD-ROM CONTENTS: SUPPLEMENTARY MATERIAL
The Initial Reports CD-ROM contains supplementary X-ray diffraction (XRD) data files presented in 
ASCII. The files present raw instrument XRD data values. Supplementary material files are located in 
the SUPP_MAT directory.

XRD_DATA

XRD_1225

1225A
01H2R0.UDF
01H2W94.UDF
02H1W123.UDF
02H5W114.UDF
03H22R13.UDF
04H1W10.UDF
05H2W49.UDF

34H2W140.UDF
35X3W47.UDF
35X3W80.UDF
35X4W142.UDF
35X5R12.UDF

1225C
01H1WR37.UDF
01H3WR65.UDF
01H4WR0.UDF
01H5WR0.UDF
02H6W56.UDF
05H6W54.UDF

06H2W90.UDF
11H3R0.UDF
13H3R0.UDF
14H1W0.UDF
15H4W53.UDF
19H3R135.UDF
20H7W53.UDF
26H1W119.UDF
27H3R135.UDF
30H5W69.UDF
33H2W28.UDF
33H3R135.UDF
34H1W4.UDF

04H1W36.UDF
05H3W57.UDF
07H1W75.UDF
10H5W98.UDF
22H1W21.UDF
27H4W63.UDF
27H4W63A.UDF
27H5W127.UDF
27H5W12A.UDF
29H3W97.UDF
29H3W97A.UDF

STANDARD
QTZ0210.UDF
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QTZ0210A.UDF
QTZ0211.UDF
QTZ0211A.UDF
QTZ0212.UDF
QTZ0213.UDF
QTZ0213A.UDF
QTZ0214.UDF
QTZ0215.UDF
QTZ0215Z.UDF

XRD_1226

1226B
01H1W3.UDF
06H4W20.UDF
06H7W57.UDF
08H6W113.UDF
12H7W53.UDF

41X1W2.UDF
43X1W19.UDF
44XCCW9.UDF
47X1W7.UDF
47X2W53.UDF
47XCC42.UDF
47XCCW0.UDF

1226E
06H6W137.UDF
06H6W19.UDF
08H4W45.UDF
18H2W87.UDF
18H6W104.UDF
18H6W77.UDF
19H3W28.UDF
22X3W35.UDF
22X3W91.UDF
29H6W104.UDF

29H7W56.UDF
30X2W111.UDF
30X4W90.UDF
30X6W99.UDF
30X7W36.UDF
31X3W19.UDF
31X5W120.UDF
32X4W111.UDF
32X4W117.UDF
33X3W125.UDF
33X5W80.UDF
34X1W110.UDF
36X1W105.UDF

25X3W104.UDF
25X3W108.UDF

STANDARD
QTZ0221.UDF
QTZ0222.UDF
QTZ0223.UDF
QTZ0224.UDF
QTZ0226.UDF
QTZ0228.UDF
QTZ0304A.UDF
QTZ0307.UDF
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XRD_1227

1227A
01H2W32.UDF
01H2W74.UDF
01H2W97.UDF
02H4W92.UDF
04H5W74.UDF
05H1W45.UDF
06H3W90.UDF
07H3W135.UDF
08HCCW20.UDF
08HCCW21.UDF
08HCW21A.UDF
12H1W85.UDF
12H1W96.UDF

1227D

XRD_1228

1228A
01H2W121.UDF
04H5W125.UDF
04H5W54.UDF
05H1W64.UDF
06H2W85.UDF
06H4W137.UDF
06H4W17.UDF
06H5W117.UDF
06H6W14.UDF
06H6W61.UDF
07H1W32.UDF
07H1W53.UDF
07H6W100.UDF
08H5W48.UDF
16H1W83.UDF
02H2W139.UDF

04H5W100.UDF
05H4W94.UDF
06H1W15.UDF
06H1W30.UDF
06H3W25.UDF

STANDARD
QTZ0302.UDF
QTZ0302A.UDF
QTZ0303.UDF
QTZ0303A.UDF
QTZ0304.UDF
QTZ0305.UDF

16H2W97.UDF

STANDARD
QTZ0305.UDF
QTZ0306.UDF
QTZ0306A.UDF

XRD_1229

1229A
01H2W70.UDF
01H3W84.UDF
02H1W105.UDF
03H1W56.UDF
08H1W62.UDF
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10H1W111.UDF
13H2W103.UDF
19H2W40.UDF
19H3W60.UDF
21H1W30.UDF

1229E
01H2W13.UDF
01H3W114.UDF
01H3W89.UDF

STANDARD
CHKMAG_1.UDF
CHKMAG_2.UDF
QTZ0308.UDF
QTZ0309.UDF
QTZ0310.UDF
QTZ0315.UDF

35X4W40.UDF
35X4W80.UDF
35X5W68.UDF

1230B
01H4W15.UDF
01H4W16.UDF
05H4W64.UDF
05H4W72.UDF
07H1W144.UDF
07H5W96.UDF
12H7W30.UDF

STANDARD
QT031702.UDF
QT031802.UDF
QTZ0315.UDF
QTZ0316.UDF
XRD_1230

1230A
02H6W15.UDF
12H2W112.UDF
26H1W39.UDF
26H2W33.UDF
30X1W93.UDF
31X1W25.UDF
31X1W93.UDF
33X2W14.UDF
33X3W100.UDF
33XCCW16.UDF
35X1W94.UDF

QTZ0316A.UDF
QTZ0319.UDF

XRD_1231

1231B
02H1W45.UDF
02H6W45.UDF
03H5W105.UDF
03H5W94.UDF
05H1W3.UDF
05H6W100.UDF
06H3W43.UDF
06H6W40.UDF
07H1W60.UDF
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07H3W60.UDF
07H6W60.UDF
08H4W60.UDF
08H4W77.UDF

08H1W27.UDF
08H5W30.UDF

1231E
08H5W60.UDF
09H1W10.UDF
11H4W80.UDF
13H3W132.UDF

1231D
03H2W30.UDF
03H6W70.UDF
05H1W20.UDF
05H1W30.UDF
06H3W135.UDF
06H4W83.UDF
06H5W135.UDF
06H6W135.UDF

04H7W51.UDF
14H2W59.UDF

STANDARD
CK0322.UDF
QTZ0322A.UDF
QTZ0323.UDF
QTZ0323A.UDF
QTZ0323B.UDF
QTZ0323C.UDF
QTZ0324.UDF
QTZ0325.UDF

README.TXT
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CD-ROM CONTENTS: DRILLING LOCATION MAPS
A site map showing the drilling locations for this leg and maps showing the drilling locations of all 
Ocean Drilling Program (ODP) and Deep Sea Drilling Project (DSDP) drilling sites are available in PDF 
format.

ODP Leg 201 Site Map 

ODP Map (Legs 100–201)

DSDP Map (Legs 1–96)
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RELATED LEG DATA

DOWNHOLE LOGGING AND CORE DATA 

A CD-ROM containing processed logging data and a subset of core data is included with the printed 
version of this volume. However, a more complete set of the logging data collected by ODP Logging 
Services is available online at www.ldeo.columbia.edu/BRG/ODP/DATABASE/DATA/search.html. If 
you have problems downloading the data, wish to receive additional logging data, or have questions 
regarding the data, please contact: Data Services Manager, ODP Logging Services, Borehole Research 
Group, Lamont-Doherty Earth Observatory of Columbia University, PO Box 1000, 61 Route 9W, 
Palisades NY 10964, USA; Tel: (845) 365-8343; Fax: (845) 365-3182; E-mail: 

logdb@ldeo.columbia.edu.

The majority of the core data on the CD are available on the Web at www-odp.tamu.edu/database. 
If you cannot access the ODP database or need additional data, please contact: ODP Data Librarian, 
Ocean Drilling Program, Texas A&M University, 1000 Discovery Drive, College Station TX 77845-
9547, USA; Tel: (979) 845-8495; Fax: (979) 458-1617; E-mail: database@odpemail.tamu.edu.

COMPILED ELECTRONIC INDEX
The Compiled Electronic Index of the Proceedings of the Ocean Drilling Program included on the volume 
CD-ROM contains individual indexes of Volumes 101–178, and 180. The indexes are contained in the 
directory titled ODPINDEX and are named ###NDX.PDF (### = the leg number). These indexes can 
be searched individually or collectively.

http://www.ldeo.columbia.edu/BRG/ODP/DATABASE/DATA/search.html
mailto:logdb@ldeo.columbia.edu
http://www-odp.tamu.edu/database
mailto:database@odpemail.tamu.edu
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CD-ROM DIRECTORY STRUCTURE 

ACROREAD
(Acrobat Reader installation 
software and instructions for 
different platforms)

201IR.PDF
(Preliminary pages and table of contents)

README.TXT

IR201_01.PDF (Leg 201 Summary)VOLUME
(Leg 201 Initial Reports volume)

README.PDF
(Information about the volume CD-ROM)

README.TXT
(ASCII version of information about the volume CD-ROM)

MAPS
(Drilling location maps)

ODPMAP.PDF
(ODP map, Legs 100 through 201)

CHAPTERS
(Volume chapters)

201_MAP.PDF
(Leg 201 site map)

IR201_02.PDF (Drilling Contamination Tests)

IR201_03.PDF (Pressure Core Sampler)

IR201_04.PDF (Infrared Thermal Imaging)

IR201_05.PDF (Explanatory Notes)

IR201_06.PDF (Site 1225)

DSDPMAP.PDF
(DSDP map, Legs 1 through 96)

TABLES
(Selected ASCII geochemistry data
tables and smear slide data tables)

IR201_03 (Appendix file)

IR201_06 (Site 1225)

IR201_07 (Site 1226)

IR201_08 (Site 1227)

S_SLIDES (Sites 1225 through 1231)

README.TXT(Continued on next page)

COR_1225.PDF (Site 1225)CORES
(Visual core descriptions, smear slide
and thin section data tables, and
digital core images)

COR_1226.PDF (Site 1226)

COR_1227.PDF (Site 1227)

IMAGES (PDF files of core images)

IR201_07.PDF (Site 1226)

IR201_08.PDF (Site 1227)

IR201_09.PDF (Site 1228)

IR201_10.PDF (Site 1229)

IR201_11.PDF (Site 1230)

IR201_12.PDF (Site 1231)

COR_1228.PDF (Site 1228)

COR_1229.PDF (Site 1229)

COR_1230.PDF (Site 1230)

IR201_10 (Site 1229)

IR201_09 (Site 1228)

MAC

UNIX

WINDOWS

IR201_11 (Site 1230)

IR201_12 (Site 1231)

COR_1231.PDF (Site 1231)
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CD-ROM DIRECTORY STRUCTURE (CONTINUED)

ODPINDEX
(Compiled Electronic Index of the
Proceedings of the Ocean Drilling
Program)

101NDX.PDF through 178NDX.PDF
and 180NDX.PDF
(Index files)

NDX.PDX
(Acrobat file used to enable Acrobat Search of the
Compiled Electronic Index)

SUPP_MAT
(Supplementary material)

XRD_DATA
(ASCII X-ray diffraction raw instrument
data)

XRD_1225 (Site 1225 files)

XRD_1226 (Site 1226 files)

XRD_1227 (Site 1227 files)

XRD_1228 (Site 1228 files)

XRD_1229 (Site 1229 files)

XRD_1230 (Site 1230 files)

VOLUME
(Continued)

INDEX.PDX
(Acrobat file used to enable Acrobat Search of the
201 Initial Reports)

XRD_1231 (Site 1231 files)

README.TXT
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